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本資料は表記のバージ ョ ンの英語版を翻訳したもので、内容に相違が生じる場合には原文を優先します。 資料によっては英語版の更新に対応していないものがあります。 日本
語版は参考用としてご使用の上、 最新情報につきましては、 必ず最新英語版をご参照く ださい。

概要
このアプ リ ケーシ ョ ン ノートでは、 AXI Quad SPI IP コアをデュアルおよびエンハンス ト  ク ワ ッ ド  モードで使用し、 SPI
フ ラ ッ シュ  メ モ リ から  1MB のデータ を読み書きする場合の SPI 帯域幅測定について説明し ます。 また、 Kintex®
UltraScale™ FPGA 用ザイ リ ンクス  KCU105 評価ボード と  Numonyx SPI メモ リ を使用して得られた測定結果を示します。サ
ンプル ソフ ト ウェア ファ イルを数か所変更すれば、 ほかのボードでも測定可能です。

リ ファレンス  デザイン システムは、Vivado Design Suite : System Edition 2014.4 に付属する  Vivado® IP インテグレーターに
よって構築されます。 IP インテグレーターでは、 プロセッサ、 インターコネク ト、 割り込みコン ト ローラー、 ペリ フェラ
ル IP コア、 メモ リ  コン ト ローラー、 UART をインスタンシエートするこ とでシステムを構築できます。デザインには、ザ
イ リ ンク スのソフ ト ウェア開発キッ ト  (SDK) を使用して構築されたソフ ト ウェアも含まれます。 このソフ ト ウェアは、
MicroBlaze™ プロセッサ サブシステム上で動作し、制御、 ステータス、 モニターの各機能を実行します。 リ ファレンス  デ
ザインの ZIP ファ イルには IP インテグレーターおよび SDK の完全なプロジェク ト  ファ イルが含まれており、 これらをデ
ザインの検討や再構築に活用したり、 新規デザインのテンプレート と して使用するこ とが可能です。

このアプリ ケーシ ョ ン ノートは、クワ ッ ド  SPI システムのインプリ メン ト方法、および axi_timer を使用してすべてのモー
ドにおける  QSPI のスループッ ト と帯域幅を測定する方法を説明します。 こ こでは、 コアはエンハンス ト  クワ ッ ド、 デュ
アル、 およびスタンダード  SPI モードに設定され、 SPI ク ロ ッ ク  レートは 100MHz です。 また、 クワ ッ ド  モードで得られ
るスループッ ト値がデュアル モードで得られる値のほぼ 2 倍になるこ と も示します。

はじめに
AXI Quad SPI コアは、 レガシ、 エンハンス ト、 XIP の各モードをサポート します。 これら  3 つのモードはさらに、 スタン
ダード、 デュアル、 ク ワ ッ ド とい う  3 つの SPI モードに分類されます。 スタンダード  モードのコマンドは 1 本のラ イン
(IO1)、 デュアル モードは 2 本のラ イン (IO0、 IO1)、 ク ワ ッ ド  モードは 4 本のラ イン (IO0、 IO1、 IO2、 IO3) を使用して
データの読み書きを実行します。レガシ モードは、以前のバージ ョ ン (v1_00a) のコアをベースとするアプリ ケーシ ョ ンを
サポート します。 エンハンス ト  モードは AXI4 メモ リ  マップド  インターフェイスをサポート し、送信および受信 FIFO で
の固定長バース ト機能をサポート します。エンハンス ト  モードは、DTR または DRR FIFO のフ ィルまたは読み出しに必要
な AXI インターフェイス時間を削減します。 これらの FIFO はコンパイル時に設定を変更でき、深さは 16 または 256 エレ
メン トのいずれかを選択可能です。 表 1 に、 各モードで使用する  AXI4 インターフェイスを示します。

使用する  SPI スレーブの種類に応じて、 3 つの SPI モードの う ちいずれか 1 つが選択されます。 表 2 に、 SPI モード とサ
ポート される  SPI ク ロ ッ ク周波数および対応する  I/O インターフェイスを示します。
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表 1 : AXI Quad SPI コアの各コンフ ィギュレーシ ョ ン モードで使用する  AXI4 インターフェイス

モード AXI4-Lite インターフェイス AXI4 インターフェイス

レガシ モード あ り -

エンハンス ト  モード - あ り

XIP モード あ り あ り
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SPI 側の帯域幅を最大にするには、 4 本のラインのすべてでデータ  ト ランザクシ ョ ンが行われるクワッ ド  モードでコアを
使用して ください。 このモードは、 Fast Read Quad Output (0x6B h)、 Fast Read Quad I/O (0xEB h)、 Quad Input Page Program
(0x32 h) コマンドをサポートするため、 SPI 帯域幅が最大限に活用できます。 これらのコマンドはいずれも  4 本の I/O ラ
インによる  SPI フラ ッシュ  メモ リへの読み書きに対応しています。

リファレンス デザイン
SPI フラ ッシュ  メモ リから  1MB を読み出す場合のシステム スループッ ト を調べるには、 性能が最適となるよ う コアをク
ワッ ド  モードに設定する必要があ り ます。 Winbond および Numonyx の SPI メモ リは、 現在ではスタンダード  モード よ り
もデュアルおよびクワッ ド  モードの使用を推奨しています。 スタンダード  モードに比べて、 デュアル モードのコマンド
は SPI 帯域幅を約 2 倍、 クワッ ド  モードのコマンドは約 4 倍改善します。

AXI Quad SPI v3.2 コアでは SPI 帯域幅が損失なく使用されます。 これは、 送信データ  FIFO にデータが存在する限り、 SPI
ク ロ ッ クが動作を継続するこ とを意味します。 DTR FIFO が半分空いた時点でデータを再度フ ィルした り、 空きスペース
がないか DTR Occupancy レジスタをポーリ ングした りするなど、 効率的なソフ ト ウェア コーディング手法を採用すれば
SPI ト ランザクシ ョ ン間にアイ ドル サイクルは発生しません。 このよ うな手法は、エンハンス ト  クワ ッ ド  モードに加えて
レガシ モードにも適用できます。 バース ト機能の追加によ り、 1MB のデータの読み書きに要する時間は、 レガシ クワ ッ
ド  モードに比べてエンハンス ト  ク ワ ッ ド  モードの方が短く な り ます。 今回の測定では、 すべて KCU105 ボード上の
Numonyx メモ リ をアクセス先と し、 100MHz の SPI ク ロ ッ クを使用しています。

表 2 : SPI モード と  SCK 分周比および I/O インターフェイス

SPI モード
SPI クロック分周比

wrt.EXT_SPI_CLK
I/O インターフェイス
(CS と  SCK は常に存在)

スタンダード 2、 4、 8、 16xn (ただし  n = 1 … 128) IO0、 IO1

デュアル 2 IO0、 IO1

クワ ッ ド 2 IO0、 IO1、 IO2、 IO3
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ハードウェア

図 1 に、 AXI Quad SPI スループッ ト測定システムのデザインを示します。

ソフ トウェア システム

アプリ ケーシ ョ ン ノートのソフ ト ウェア デザインには、書き込みスループッ ト と読み出しスループッ トの両測定が含まれ
ます。 

図 2 は、 AXI4 メモ リ  マップド  インターフェイスを含むシステムでスループッ ト を測定するために、 SPI フラ ッシュ  メモ
リに 1MB のデータを書き込む場合を示しています。

X-Ref Target - Figure 1

図 1 : スループッ ト測定システム デザイン  - エンハンスト  クワッ ド  モード
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X-Ref Target - Figure 2

図 2 :  ソフ トウェア フローチャート  - エンハンスト  クワッ ド  モード書き込みト ランザクシ ョ ン
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図 3 に、 SPI フラ ッシュ  メモ リから  1MB のデータを読み出す場合のソフ ト ウェア フローチャート を示します。

X-Ref Target - Figure 3

図 3 :  ソフ トウェア フローチャート  - エンハンスト  クワッ ド  モード読み出し ト ランザクシ ョ ン
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書き込みおよび読み出しのプロセスの相違

すべての SPI フラ ッシュ  デバイスは 8 ビッ ト  インターフェイス  モードを備えています。 実際のデータ伝送が開始される
のは、 コマンド、 アドレス  バイ ト、 ダ ミー バイ トが送信された後です。 このデータは 8 ビッ ト  パケッ ト  モードで伝送さ
れます。 フラ ッシュ書き込みはシングル ページに限られる一方、読み出しにはそのよ うな制約があ り ません。チップ セレ
ク トがアサート され、 SPI ク ロ ッ クがアクティブである限り、 SPI フラ ッシュはホス トへのデータ送信を継続します。 これ
は、 読み出し とは異なり、 SPI デバイスの書き込みプロセスが比較的低速であるこ とを意味します。

ツール フローおよび検証

表 3 に、 付属のリ ファレンス  デザインで使用されるツール フローおよび検証手順を示します。

必要な環境

ハードウェア

このシステムに必要なハードウェア ボード、 その他の機器は次のとおりです。

• ザイ リ ンクス  KCU105 評価ボード  (Rev B)

• JTAG USB プラ ッ ト フォーム ケーブルまたは Type-A/Micro-B USB ケーブル

• uart データ伝送用マイクロ  USB ケーブル

ソフ トウェア

• Vivado IP インテグレーター 2014.4

• Vivado Design Suite : System Edition 2014.4

• SDK 2014.4

表 3 : リファレンス デザインの詳細

パラメーター 説明

全般

開発者 Prasad Gutti

ターゲッ ト  デバイス  Kintex UltraScale FPGA
XCKU040-FFVA1156-2-E

ソース  コードの提供 あ り

ソース  コードの形式 VHDL/Verilog (一部コアは暗号化済み)

既存のザイ リ ンクス  アプリ ケーシ ョ ン ノート / リ ファレン
ス  デザイン、またはサードパーティからデザインへのコー
ド /IP の使用 

SDK 用に提供された リ ファレンス  デザインおよび Vivado
IP カタログから生成されるコア

インプリ メンテーシ ョ ン

使用した合成ツール/バージ ョ ン Vivado 合成

使用したインプリ メンテーシ ョ ン ツール/バージ ョ ン Vivado インプリ メンテーシ ョ ン

スタティ ッ ク  タイ ミ ング解析の実施 あ り  (PAR/TRCE のタイ ミ ングにパス)

ハードウェア検証 

ハードウェア検証の実施 あ り

使用したハード ウェア プラ ッ ト フォーム KCU105 評価キッ ト
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リファレンス デザイン  ファイル

リ ファレンス  デザインのデザイン ファ イルは、 次のリ ンク先からダウンロードできます。 

• デュアル モード  リ ファレンス  デザイン - https://secure.xilinx.com/webreg/clickthrough.do?cid=378726

• クワ ッ ド  モード  リ ファレンス  デザイン - https://secure.xilinx.com/webreg/clickthrough.do?cid=378727

ダウンロードには登録が必要です。

図 4 に、このアプリ ケーシ ョ ン ノートに付属するデザイン ファ イルのディ レク ト リ構造を示します。このアプリ ケーシ ョ
ン ノートにはエンハンス ト  クワ ッ ドおよびデュアル QSPI の各モードに対応する  2 つのシステムが含まれます。

xapp1234_kcu105_enh_quad_mode.zip ファ イルには次のファイルおよびフォルダーが含まれます。

xapp1234_kcu105_enh_quad_mode : 最上位フォルダーです。

HW : このフォルダーには、 local_pcores フォルダー、 all.tcl、 design_1_wrapper.vhd、 kcu105.xdc の各
ファイルが含まれます。

local_pcores : このフォルダーは空であ り、 システムでローカル pcore が使用されている場合はその pcore をこの
フォルダーに格納できます。

all.tcl : このファイルには、 Tcl コマンドを使用する、 クワ ッ ド  SPI エンハンス ト  クワ ッ ド  モード用の MicroBlaze
ベースの完全なハードウェア システムが含まれます。

kcu105.xdc : このファ イルには、ピンを介して外部ペリ フェラルへ接続する際に使用する、 クワ ッ ド  SPI 用システ
ムと  UART Lite IP に必要な LOC 制約が含まれます。

design_1_wrapper.v : 最上位ラ ッパー ファ イルです。 このファイルには、 システムの最上位ポートが含まれ、 この
ファイルに対して STARTUPE3 がインスタンシエート されています。STARTUPE3 は、クロ ッ クを SPI フラ ッシュ
メモ リに転送するために使用します。

ready_for_download : このフォルダーには、 design_1_wrapper_enh_quad_mode.bit および
kcu105_enh_quad_perf.elf ファ イルが含まれます。design_1_wrapper_enh_quad_mode.bit ファ イルのダ
ウンロードには、 XMD コマンドの fpga を使用します。 kcu105_enh_quad_perf.elf ファ イルのダウンロードに
は、 XMD コマンドの dow を使用します。

SDK : このフォルダーには、エンハンス ト  クワ ッ ド  モードのクワ ッ ド  SPI システムのスループッ ト性能を測定するた
めにシステムが使用するソフ ト ウェア ファ イルが含まれます。

xapp1234_kcu105_enh_dual_mode.zip ファ イルには次のファイルおよびフォルダーが含まれます。

X-Ref Target - Figure 4

図 4 : ディレク ト リ構造

https://secure.xilinx.com/webreg/clickthrough.do?cid=378726
https://secure.xilinx.com/webreg/clickthrough.do?cid=378727
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xapp1234_kcu105_enh_dual_mode : 最上位フォルダーです。

HW : このフォルダーには、 local_pcores フォルダー、 all.tcl、 design_1_wrapper.vhd、 kcu105.xdc の各
ファイルが含まれます。

local_pcores : このフォルダーは空であ り、 システムでローカル pcore が使用されている場合はその pcore をこの
フォルダーに格納できます。

all.tcl : このファイルには、 Tcl コマンドを使用する、 クワ ッ ド  SPI エンハンス ト  デュアル モード用の MicroBlaze
ベースの完全なシステムが含まれます。

kcu105.xdc : このファ イルには、ピンを介して外部ペリ フェラルへ接続する際に使用する、 クワ ッ ド  SPI 用システ
ムと  UART Lite IP に必要な LOC 制約が含まれます。

design_1_wrapper.vhd : 最上位ラ ッパー ファ イルです。 このファイルには、 システムの最上位ポートが含まれ、 こ
のファ イルに対して STARTUPE3 がインスタンシエート されています。 STARTUPE3 は、 ク ロ ッ クを SPI フラ ッ
シュ  メモ リに転送するために使用します。クワ ッ ド  SPI デュアル モード  デザインでは、Quad SPI IP が SPI フラ ッ
シュ  データを送受信する際、 2 本の SPI_IO ラインしか使用されません。 

注記 : Kintex UltraScale FPGA には制限があるため、 システムでは 4 本の I/O ピンがすべて使用されています。 そ
れらのうち 2 本は IO0 と  IO1 に接続され、 残りの 2 本はシステムで、 問題の回避を目的と したダ ミーと して使用
されます。

ready_for_download : このフォルダーには、 design_1_wrapper_enh_dual_mode.bit および
kcu105_enh_dual_perf.elf ファ イルが含まれます。design_1_wrapper_enh_dual_mode.bit ファ イルのダ
ウンロードには、 XMD コマンドの fpga を使用します。 kcu105_enh_dual_perf.elf ファ イルのダウンロードに
は、 XMD コマンドの dow を使用します。

SDK : このフォルダーには、エンハンス ト  デュアル モードのクワ ッ ド  SPI システムのスループッ ト性能を測定するた
めにシステムが使用するソフ ト ウェア ファ イルが含まれます。
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リファレンス デザインの手順

セッ トアップ

図 5 に、 スループッ トの測定を目的と したハード ウェア セッ ト アップを示します。 

1. BIT ファ イルと  ELF ファ イルをプログラムするために、 JTAG USB プラ ッ ト フォーム ケーブルまたは USB Type A/
Micro B ケーブルをホス ト  PC から  KCU105 ボードへ接続します。(このセッ ト アップでは JTAG プラ ッ ト フォーム ケー
ブルを使用)

2. ホス ト  PC と  KCU105 ボードのシ リ アル通信用 USB UART ポート を Micro USB ケーブルで接続します。

3. 電源ケーブルを接続し、 KCU105 ボードの電源を投入します。

4. ホス ト  PC 上で PuTTY プログラムを、 次の設定で起動します。

° ボー レート  : 9600

° データ  ビッ ト  : 8

° パリティ  : なし

° ス ト ップ ビッ ト  : 1

° フロー制御 : なし

リファレンス デザインの実行

このセクシ ョ ンでは、ハード ウェアおよびソフ ト ウェアの両方について リ ファレンス  デザインを構築する方法を説明しま
す。

1. 構築を開始する前に、 リ ファレンス  デザインをローカル ディ レク ト リに解凍します。 この手順では、 リ ファレンス
デザインを 「XAPP1234」 と表記します。

2. 次に示す手順のいずれかを実行します。

X-Ref Target - Figure 5

図 5 : ハードウェアのセッ トアップ
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° リ ファレンス  デザインを構築し  (BIT および ELF ファ イルの生成を含む)、ハード ウェアでテス ト します。 これを
実行するには、 次のセクシ ョ ンに記載の手順に従います。

- 「 リ ファレンス  デザインを構築する」

- 「ハード ウェアでデザインを実行する」

または 

° XAPP1234 リ ファレンス  デザインに含まれる、生成済みの BIT および ELF ファ イルを使用し、ハード ウェアでテ
ス ト します。 これを実行するには、 次のセクシ ョ ンに記載の手順に従います。 

- 「ハード ウェアでデザインを実行する」、 特に 手順 2 にある 「重要」 の記載事項に注意が必要です。

リファレンス デザインを構築する

以降のセクシ ョ ンでは、 ハード ウェア デザイン生成し  (BIT および ELF ファ イルの生成を含む)、 SDK ワークスペースを
構築する際の手順を説明します。 

注記 : XAPP1234 リ ファレンス  デザインに含まれる  BIT および ELF ファ イルを使用する場合はこのセクシ ョ ンを無視し、
「ハード ウェアでデザインを実行する」 に進んでください。

Vivado デザイン  ツール プロジェク ト を作成し、 ビッ トス ト リームを生成する

こ こでは、 Vivado Design Suite 2014.4 で新規プロジェク ト を開始する手順について説明します。

1. Vivado Design Suite を起動します。

2. Vivado 統合設計環境 (IDE) で [Tcl Console] ビューを開きます。 [Tcl Console] ビューが表示されない場合は、 [Window]
→ [Tcl Console] をク リ ッ ク します。

3. [Tcl Console] に次のコマンドを入力し、 HW ディレク ト リに移動します。

cd xapp1234_kcu105_enh_quad_mode/HW

または

cd xapp1234_kcu105_enh_dual_mode/HW

4. 提供されている  all.tcl ファ イルを source コマンドで実行します。

source all.tcl

プロジェ ク ト が作成される と、 Vivado Design Suite は出力ファ イルの生成、 デザインの合成と インプ リ メ ンテーシ ョ ン、
ビッ ト ス ト リームの生成を実行します。

http://japan.xilinx.com
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図 6 に、 システムで MicroBlaze プロセッサを用いた場合の全 IP コアのアドレス  マップを示します。 

SDK でハードウェア ワークスペースをエクスポートする

ビッ ト ス ト リームの生成が完了したら、 次を実行します。 

1. SDK ですでにエクスポート されているハード ウェア ワークスペースを開きます。

2. xsdk GUI を開きます。

3. ワークスペース  パスを 「project_1/project_1.sdk」 と し、 [OK] をク リ ッ ク します。

4. SDK で次を実行します。

a. [File] → [New] → [Board Support Package] をク リ ッ ク し、 BSP を生成します。

b. [File] → [New] → [Applicaton project] をク リ ッ ク し、 新しい空のプロジェク ト を作成します。 プロジェク ト名を
「kcu105_enh_quad_perf」 と し、 このプロジェク トについては [Use Existing BSP] を選択します。 

5. パッケージに含まれるソフ ト ウェア ソース  コードを SDK から  src フォルダーにインポート します。

次に、 ELF ファ イルが生成されます。

X-Ref Target - Figure 6

図 6 : IP インテグレーターにおける  IP コアのベース アドレスと高位アドレス

http://japan.xilinx.com
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ハードウェアでデザインを実行する

次の手順に従って、 ハード ウェア セッ ト アップにビッ ト ス ト リームおよび ELF ファ イルを使用します。

1. JTAG ケーブルと  USB-UART ケーブルをボードに接続します。

2. test フォルダーを作成します。

重要 : XAPP1223 リ ファレンス  デザインに含まれる、生成済みの BIT および ELF ファ イルへアクセスするには次を実行し
ます。
- ready_for_download フォルダーへ移動する  (テス ト  フォルダーを作成しない場合)
- 手順 3、 手順 4 および手順 5 をスキップし、 手順 6 から実行する

3. design_1_wrapper.bit ファ イルを project_1/project_1.runs/impl_1/ からコピーし、 test フォルダー
にペース ト します。

4. kcu105_enh_quad_perf.elf ファ イルを project_1/project_1.sdk/kcu105_enh_quad_perf/Debug/
フォルダーからコピーし、 test フォルダーにペース ト します。

5. 次のコマンドを入力して test フォルダーに移動します。 

cd test

6. コマンド  プロンプ トで xmd と入力し、 ザイ リ ンクス  マイ クロプロセッサ デバッガー (XMD) を起動します。

7. XMD プロンプ トに次のコマンドを入力して、JTAG ケーブルから  FPGA を design_1_wrapper.bit でコンフ ィギュ
レーシ ョ ンします。

fpga -f design_1_wrapper.bit

8. 次のコマンドを入力して FPGA 上で動作するプロセッサに接続します。 

connect mb mdm

9. XMD プロンプ トに次のコマンドを入力して FPGA を リセッ トおよび停止します。

rst
stop

10. 結果を確認するためにハイパーターミナルを起動し、 デフォルト  コンフ ィギュレーシ ョ ンでボー レートは 9600 に設
定します。 ボード と  PC に UART ケーブルが接続されているこ とを確認してください。

11. ELF ファ イルをメモ リ  (ブロ ッ ク  RAM または DDR) にダウンロード し、 ソフ ト ウェアをボードで実行します。 

stop; rst; dow kcu105_enh_quad_perf.elf
run

12. テス トが完了する とハイパーターミナルに SUCCESS、 PASSED、 または FAILED と表示されます。

stop

結果

図 7 と図 8 に、 出力画面の例を示します。

http://japan.xilinx.com
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参考資料
1. 『AXI Quad SPI IP (Kintex-7) コア用スループッ ト性能の測定』 (XAPP797 : 英語版、 日本語版)

2. 『LogiCORE IP AXI Quad SPI 製品ガイ ド』 (PG153)

3. 『Spartan-3A DSP 1800A スターター プラ ッ ト フォームで SPI を利用したフラ ッシュ  メモ リからのブート ロード』
(XAPP1053 : 英語版)

4. 『Vivado Design Suite ユーザー ガイ ド  : IP インテグレーターを使用した IP サブシステムの設計』 (UG994)

X-Ref Target - Figure 7

図 7 :  エンハンスト  クワッ ド  モードの出力例

X-Ref Target - Figure 8

図 8 : エンハンスト  デュアル モードの出力例
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http://japan.xilinx.com/cgi-bin/docs/ipdoc?c=AXI%20Quad%20SPI
http://japan.xilinx.com/support/documentation/application_notes/xapp1053.pdf
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改訂履歴
次の表に、 この文書の改訂履歴を示します。

法的通知
The information disclosed to you hereunder (the "Materials") is provided solely for the selection and use of Xilinx products.To the maximum extent
permitted by applicable law:(1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES AND
CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort, including
negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in connection with, the
Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss or damage (including loss of
data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party) even if such damage or loss was reasonably
foreseeable or Xilinx had been advised of the possibility of the same.Xilinx assumes no obligation to correct any errors contained in the Materials or to
notify you of updates to the Materials or to product specifications.You may not reproduce, modify, distribute, or publicly display the Materials without
prior written consent.Certain products are subject to the terms and conditions of Xilinx's limited warranty, please refer to Xilinx's Terms of Sale which can
be viewed at http://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and support terms contained in a license issued to you by
Xilinx.Xilinx products are not designed or intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and
liability for use of Xilinx products in such critical applications, please refer to Xilinx's Terms of Sale which can be viewed at
http://www.xilinx.com/legal.htm#tos.

© Copyright 2015 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated brands included herein are
trademarks of Xilinx in the United States and other countries.All other trademarks are the property of their respective owners.
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